
 

 

 

E&P SOFTWARE PLATFORM 

Version 2019 
INSTALLATION GUIDE 

 

 
 
  



     

 

  12 June 2019 

Schlumberger Private – Customer Use 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 



 

 
Schlumberger Private - Customer Use 

 

Copyright Notice 

Copyright © 2019 Schlumberger. All rights reserved. 

This work contains the confidential and proprietary trade secrets of Schlumberger and may not be copied or 
stored in an information retrieval system, transferred, used, distributed, translated or retransmitted in any form 
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copyright owner. 

Trademarks & Service Marks  
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Schlumberger Product Documentation 

About Schlumberger 

Schlumberger is the leading oilfield services provider, trusted to deliver superior 
results and improved E&P performance for oil and gas companies around the world. 
Through our well site operations and in our research and engineering facilities, we 
develop products, services, and solutions that optimize customer performance in a 
safe and environmentally sound manner. 

Online Documentation 

Documentation is provided in the following electronic formats on the Schlumberger 
product CD: 

• Adobe® Acrobat® PDF files 

• Online help 

You must have Adobe® Reader® installed to read the PDF files. Adobe Reader 
installation programs for common operating systems are available for a free 
download from the Adobe Web site at www.adobe.com. 

Typestyle Conventions 

These conventions are observed throughout this guide: 

• Bold text designates file and folder names, dialog titles, names of buttons, 
icons, and menus, and terms that are objects of a user selection.  

• Italic text emphasizes words, defined terms, and manual titles. 

• Monospace text (Courier) shows literal text as you would enter it, or as it 

would appear onscreen. 

Alert Statements 

The alerting statements are Notes, Cautions, and Warnings. These statements are 
formatted in these style: 

Note: Information that is incidental to the main text flow, or to an important point 
or tip provided in addition to the previous statement or instruction. 

 

Caution:  Advises of machine or data error that could occur should the user fail to 
take or avoid a specified action. 

 

Warning:  Requires immediate action by the user to prevent actual loss of data or 
where an action is irreversible, or when physical damage to the 
machine or devices is possible. 
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Contacting Schlumberger 

Technical Support 

Schlumberger has sales and support offices around the world. For information about 
contacting Schlumberger, please refer to the information below: 

For Technical Support information for Software Integrated Solutions (SIS) software: 

• Software Support website: https://www.software.slb.com/support 

• Customer Care Center e-mail: customercarecenter@slb.com 

• Support Contact Details - Select your country to view support phone numbers. If 
your country is not listed, select the nearest location. 
http://www.software.slb.com/support/contact-details 

  

https://www.software.slb.com/support
mailto:customercarecenter@slb.com
http://www.software.slb.com/support/contact-details
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2 Overview 

In This Chapter 

Introduction ..................................................................................................................... 2-2 

Petrel 2019 Distribution ..................................................................................................... 2-3 

About Petrel Licensing ....................................................................................................... 2-4 
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Introduction 

This guide explains how to install the Petrel E&P Software Platform 2019. These 
topics are discussed: 

• Installing on a workstation using a local license 

• Installing on a workstation using a license on a central license server 

This guide also explains the procedures that are required after installation: 

• Defining your license server environment 

• Selecting your license package  

Additionally, this guide includes detailed information about deploying Petrel 2019 on 
a network shared disk. Refer to “Deploying Petrel on a Network Shared Disk” on 
page 4-7. 

Audience 

This guide is useful for these people: 

• An individual who installs Petrel on a workstation  

• The system administrator who installs Petrel on a network shared disk or creates 
and distributes a global configuration file for Petrel 
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Petrel 2019 Distribution 

The Software Download Center distributes Petrel 2019 at www.sdc.oilfield.slb.com 

The Ocean* Store provides Petrel plug-ins at www.ocean.slb.com 

Petrel 2019 requires a workstation with a 64-bit architecture and an operating 
system that supports this architecture.  

file:///C:/Users/mdawson7/AppData/Roaming/Microsoft/Word/www.sdc.oilfield.slb.com
http://www.ocean.slb.com/
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About Petrel Licensing 

Petrel 2019 requires the 2017 version of the Schlumberger License server, which is 
distributed with the Petrel DVD. The new server is backward compatible with all 
previous Petrel release versions. The Petrel 2019 License selection dialog will 
throw an error message if it attempts to connect to a previous Licensing tool. 

Petrel 2019 requires a valid license. The license can be configured either locally on 
your computer or on a central license server.  

Petrel 2019 uses a combination of FlexeraTM FlexNet Publisher® licensing and a 
WIBU® CodeMeter® dongle. This provides a secure licensing solution. 

Notes: • This version of Petrel requires a Petrel 2017 license file. Licenses for 
this release are backward compatible with all previous release 
versions. 

• For information about the Schlumberger Licensing Tool, refer to the 
Schlumberger Licensing User Guide, located in the installation folder 
of the Petrel installation files (for example, C:\Program 

Files\Schlumberger\Petrel 2019\Help). 
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3 Site Assessment 
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System Requirements 

Table 3-1 lists the minimum system requirements and the preferred system 
requirements for Petrel 2019. The preferred system includes the minimum 
requirements to efficiently support Geophysics workflows. 

Table 3-1 Petrel 2019 System Requirements  

Minimum System Recommendations 

Processor Quad-core processor (best with a fast clock speed 
and high cache) 

Memory 16 GB RAM (32+ GB recommended) 

Display The quality of the viewing experience increases with 
the size and number of monitors 

Graphics Desktop NVIDIA® Quadro® P4000 or NVIDIA Quadro P2000  

Graphics Mobile NVIDIA Quadro P3000 or NVIDIA Quadro M2200 

Primary storage Fast rotational speed HDD (10K, 15K RPM) or SSD 

Secondary storage Optional 

Preferred Hardware 

Processor Dual 4 to 8 core processor (best with a fast clock 
speed and high cache) 

Memory 64 GB RAM 

Display The quality of the viewing experience increases with 
the size and number of monitors 

Graphics Desktop NVIDIA Quadro P6000 or P5000 

Graphics Mobile NVIDIA Quadro P5000 or P4000 

Primary storage PCIe based Flash or SSD 

Secondary storage SSD or Fast rotational speed HDD (10K, 15K) 

Other Required Software 

Microsoft® .NET® Framework 4.6.2 minimum, 4.7 or newer recommended 
(Tech Alert #6858030) 

Notes: • Petrel has known issues with .NET Framework 4.6.0 and the installer 
will not install Petrel if this .NET version is detected (on Windows 
10, .NET is an OS component installed by default). 

 • Schlumberger continually tests the latest hardware available from 
major suppliers. In an attempt to minimize unexpected problems 
and costs, Schlumberger often uses branded solutions such as those 
offered by HP®, Dell®, Lenovo®, Intel®, and NVIDIA. 
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Operating Systems and Hardware Selections 

Operating Systems 

Table 3-2 Petrel 2019 Supported Operating Systems  

Operating System 

64-bit Windows 10 (Professional and Enterprise editions) 

64-bit Windows 7 with SP1 (Professional and Enterprise editions) 

Note: Windows 10 updates – Microsoft supports semi-annual update channel 
(includes .NET) – future Petrel versions will be supported on the current 
channel update at the Petrel release date. 

Note: Support for virtual reality (VR) has been removed from Petrel 2017 onward. 

Processors 

Processor speed improves performance for these types of tasks: 

• Large calculation tasks, such as volume size, seismic attribute generation, 
property modeling, and upscaling 

• Adding information to the graphics card 

For general Petrel use, a processor that meets the minimum recommendations is 
sufficient. For better performance, use the best available configuration (refer to 
Table 3-1).  

Several Petrel 2019 modules can benefit from multi-core processors. 
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Table 3-3 Petrel Modules that Benefit from Multi-Core Processors 

 Parallel Background 

Geophysics: For more information, refer to “Petrel Geophysics 
Recommendations” on page 3-9.  

Seismic read access of ZGY Yes Yes 

Volume attribute computation Yes Yes 

Prefetch to cache 3D seismic data Yes Yes 

Local 3D horizon – read access for Yes Yes 

Multiresolution computation for viz 

• Horizons for seismic 3D 

• Seismic 2D lines 

Yes Yes 

Seismic 3D realization from any 
source – ZGY / SEGY / RAW 

Yes Yes 

Seismic 3D read access for 3D viz 
using slice renderer – SEGY / RAW 

Yes Yes 

Seismic 3D export to SEG-Y Yes No 

Decompression of compressed ZGY Yes Yes 

Prefetch to cache SEG-Y No Yes 

Prefetch to cache RAW seismic No Yes 

3D seismic interpretation No Yes 

Seismic interpretation min/max 
queries 

Yes No 

Seismic histogram scan Yes Yes 

Seismic copy local No Yes 

Make compressed ZGY Yes Yes 

Ocean prestack seismic access Yes Yes 

Geology and Modeling  

Data analysis No Yes 

Facies and Petrophysical modeling Yes No 

Geometrical modeling (incl seismic 
sampling) 

Yes No 

3D grid volumetrics Yes No 

Surface Volumetrics Yes No 
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 Parallel Background 

Gridding   

Structural gridding Yes No 

Grid refinement process Yes No 

Mesh skin extraction for 3D grid 
property visualization 

Yes Yes 

 

Petrel Modeling Recommendations 

Several modeling algorithms in Petrel 2019 take advantage of multi-core processing. 
Increasing the number of processors improves the runtime of these algorithms. This 
current trend of converting algorithms to run in parallel will continue, based on 
algorithm runtime. 

Memory (RAM) 

To run Petrel efficiently, Schlumberger requires at least 16 GB of RAM and 
recommends at least 32 GB (64 GB for Geophysics workflows). The total system 
memory must be greater than the memory used by the application. This ensures that 
your operating system has dedicated RAM so that you do not need use your page file 
(disk memory). 

To estimate the required system size, follow these guidelines: 

• For small- to medium-sized data sets (<5 GB): 32 GB of memory 

• For large data sets (large 3D seismic volumes, regional seismic models, or large 
simulation [ECLIPSE] runs): 64 to 192+ GB of RAM 

Graphics Cards 

Table 3-4 lists the recommended, tested graphics cards for Petrel 2019. Your 
graphics card must meet these requirements: 

• Run Pixel Shader 2.0 or later 

• Be OpenGL compatible 

For a better visualization experience, use a high-end graphics card and a good 
monitor (such as a 27‒30-inch LCD monitor or Ultra High Definition 4K monitors). 
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Table 3-4 Petrel 2019 Recommended Graphics Cards 

Level Level Dedicated 

RAM 

GPU Cores 

Workstation, Ultra High End NVIDIA Quadro P6000 24 GB 3840 

NVIDIA Quadro P5000 16 GB 2560 

Workstation, High End NVIDIA Quadro P5000 16 GB  2560 

Workstation, Mid-Range NVIDIA Quadro P4000  8 GB 1792 

Mobile Workstation, Ultra 
High End 

NVIDIA Quadro P5000 16 GB 2048 

Mobile Workstation, High 
End 

NVIDIA Quadro P4000 8 GB 1792 

Mobile Workstation Mid-
Range 

NVIDIA Quadro P3000 6 GB 1280 

Note: Petrel is certified and supported on NVIDIA Quadro graphics cards only. 
Integrated graphics cards are not recommended. From Petrel 2017 onward, 
NVIDIA Quadro FX graphics cards are no longer supported. 

Note: NVIDIA Quadro RTX GPUs are also recommended and supported for use 
with Petrel 2016 or later. 

Selecting the Right Graphics Card 

Petrel automatically manages graphics card memory for most data types and 
windows. Choosing the right graphics card optimizes Petrel visualization 
performance. Petrel enables rendering and computation on the graphics card for 
many data objects, such as seismic, well data, surfaces, point, and polygons. 
Therefore, it is important to scale your graphics card towards the expected needs.  

Table 3-5 provides a basic overview and recommendation for selected data types.  

Table 3-5 Workflow-Specific Graphics Card Recommendations  

Data Type Size Recommended 

Graphics Card 

Recommended GPU 

Memory and Cores 

Recommend 

RAM 

Seismic  1 GB P2000 or better 

M2200 or better 

Memory: 4 GB+ 

GPU cores: 700+ 

16 GB + 

 >10GB P5000 

 

Memory: 8 GB+ 

GPU cores: 1500+ 

64 GB+ 

 >50 GB P6000 Memory: 12 GB+ 

GPU cores: 3000+ 

128 GB+ 
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Data Type Size Recommended 

Graphics Card 

Recommended GPU 

Memory and Cores 

Recommend 

RAM 

Wells  1000 P2000 or better 

M2200 or better 

Memory: 4 GB+ 

GPU cores: 700+ 

16 GB + 

 >10000 P5000 

 

Memory: 8 GB+ 

GPU cores: 1500+ 

32 GB+ 

 >250000 P6000 Memory: 12 GB+ 

GPU cores: 3000+ 

64 GB+ 

Surfaces 
(cells) or 
points 

>1 mill P2000 or better 

M2200 or better 

Memory: 4 GB+ 

GPU cores: 700+ 

16 GB + 

 >10 mill P5000 

 

Memory: 8 GB+ 

GPU cores: 1500+ 

32 GB+ 

 >100mill P6000 Memory: 12 GB+ 

GPU cores: 3000+ 

64 GB+ 

3D grids 
(cells) 

>1 mill P2000 or better 

M2200 or better 

Memory: 4 GB+ 

GPU cores: 700+ 

16 GB + 

 >10 mill P5000 

 

Memory: 8 GB+ 

GPU cores: 1500+ 

32 GB+ 

 >100mill P6000 Memory: 12 GB+ 

GPU cores: 3000+ 

64 GB+ 

Note: From Petrel 2016.1 onwards, the option Workstation App – Dynamic 
Streaming in the NVIDIA Control Panel under 3D settings > Manage 3D 
settings is set by default through the application to ensure optimal 
performance for Petrel, when visualizing data in the 2D or 3D windows.  

NVIDIA Tested Drivers 

Release 412.16 is the latest recommended and tested official driver from NVIDIA 
for both workstations and mobile workstations. Schlumberger recommends 
upgrading to the latest official drivers from your PC vendor's home page or directly 
from NVIDIA.  

Testing shows that NVIDIA drivers 362.56 and later fix many critical issues that 
support Petrel. Accordingly, release 362.56 is the minimum required driver for 
NVIDIA graphics cards. 
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Notes: • According to NVIDIA, after release 375, any subsequent Windows 
driver release starting with release 378 will cease to support the 
following NVIDIA Quadro products: 

Quadro 
Quadro 
Blade/Embedded 

Quadro Notebook 

Quadro Plex 7000 Quadro 4000M Quadro 5010M 

Quadro 6000 Quadro 3000M Quadro 5000M 

Quadro 5000 Quadro 100M Quadro 4000M 

Quadro 4000 Quadro 500M Quadro 3000M 

Quadro 2000  Quadro 2000M 

Quadro 2000 D  Quadro 1000M 

Quadro 600   

The NVIDIA support team will continue to address critical driver 
issues for these products in Release 375 through March 1, 2018. 
However, future enhancements and optimizations in driver releases 
after Release 375 will not support these products. 

• NVIDIA SLI™ technology currently does not benefit Petrel. However, 
this technology could be an advantage if you are using a large, high-
resolution monitor such as 30-inch LCD monitors. 

Disable NVIDIA Optimus 

The NVIDIA Optimus feature is incompatible with Petrel.  

 To Disable Optimus 

1 Reboot the system. 

2 Access the BIOS settings. 

3 Go to the video section. 

4 Disable Optimus. 

5 Reboot the system. 

To read more about NVIDIA’s Optimus Technology, refer to 
http://www.nvidia.com/object/optimus_technology.html. 

  

http://www.nvidia.com/object/optimus_technology.html
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Support for 4K (and Higher Resolution) Monitors 

4K (and higher resolution) monitors can be used with Petrel 2019 with low, medium, 
and high DPI settings, ranging from 100% to 200% DPI and possibly even higher. 
The advised display setting using 4K resolution (3840x2160) is 150-175% DPI. In 
this scenario, Petrel UIs should remain functional and usable and not prevent any 
user interactions.  

Note: To set 175%, click Set custom text size (DPI), make your selection and 
sign out/sign in. 

Minor cosmetic side effects might be noticed at very high DPI settings. An option, if 
this is disturbing, is to reduce the resolution to e.g. 3K (2560x1440) in combination 
with 100% or 125% DPI. In that scenario, all UIs should scale correctly.  

In Petrel 2019 it is no longer necessary to set the application Compatibility mode as 
Petrel now does this automatically. 

Note for Windows 10: The Display settings dialog box has an option for dynamic 
display scaling. This is simply a monitor magnifier, and everything on the screen will 
be scaled. The scaling approach is sub-optimal. Sign out/Sign in is strongly 
recommended for the best display scaling quality and experience. 

Note: 4K monitors have a significantly higher number of pixels which require 
sufficient graphics card support. 

Note: In a multi-monitor setup, the best results are achieved where all the 
monitors have the same resolution (different scaling has no detrimental 
effect, for example, a 4K laptop @250% + a 4K 32” monitor @150%). 
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Ergonomics and Alternative Input Devices 

Petrel ribbons and other features are designed to improve the overall ergonomics. 
Data-centered workflows are supported through tools like Petrel Search, window 
toolbars, tool palettes, inspectors, object players, context menus and mini-toolbars. 
Furthermore, global and in-context keyboard shortcuts are available for direct action. 
Finally, ribbons can be navigated via key tips (invoked with the keyboard ALT key). 

We are aware that people can have ergonomic issues, and that there are products 
out there, which can help to reduce such issues. Many of these products may work 
with Petrel, although we cannot guarantee that they will. 

One product that has worked with Petrel is the 3Dconnexion Space Mouse 
joystick (www.3dconnexion.com). Petrel has built-in support for space mouse 
joystick control of the 3D Window camera movements. See Schlumberger Customer 
Care Center for more info: CCC Knowledge Article kb6948320. 

Petrel should in principle work with any Microsoft Windows compatible input device. 
Below are some examples of other devices that may work with Petrel. Others may 
also work with Petrel. 

Wacom Cintiq 27QHD pen and touch display (http://www.wacom.com) 

• Pressure sensitive pen 

• Remote control with customizable buttons 

• Screen can be tilted 

 

Evoluent Vertical Mouse (https://evoluent.com) 

• Ninety degree rotation of the hand position 

• Right-handed and left-handed versions 

 

Sun-Flex ProTouch touch and button pad (http://www.sun-
flex.com/en/products/protouch/) 

• Placed in front of the keyboard 

• Standard mouse features (mouse buttons and cursor control) 

 

    

http://www.3dconnexion.com/
https://www.software.slb.com/support/library/kbarticles/kb6948320
http://www.wacom.com/
https://evoluent.com/
http://www.sun-flex.com/en/products/protouch/
http://www.sun-flex.com/en/products/protouch/
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Recommended Tested Hardware Solutions 

Schlumberger regularly tests hardware from a variety of vendors.  

Table 3-6 and Table 3-7 list a sampling of the hardware products used in the Petrel 
commercialization cycle. For detailed information about the laptops and workstations 
listed here, contact the SIS organization. 

Notes: • Schlumberger routinely tests the latest hardware available from 
major suppliers. To minimize unexpected problems and costs, 
contact your Schlumberger sales representative. 

• Most hardware vendors offer highly customizable options of each 
workstation model. To ensure that your workstation selection meets 
Petrel system requirements, note the individual workstation 
specifications instead of relying on a model number. As a general 
rule, the hardware used should not be more than two years older 
than the Petrel version running on it.  

Table 3-6 Laptops tested for Petrel 2019 

High-End Laptops Mid-Range Laptops 

• Dell 7730/7530 

• HP Zbook 17/15 

• Lenovo P72/P52 

• Dell 5530 

• HP Zbook Studio 

• Lenovo P52s 

Table 3-7 Workstations tested for Petrel 2019 

High-End Workstations Mid-Range Workstations 

• Dell T7920/T7820  

• HP Z8/Z6  

• Lenovo P920/P720 

• Dell T5820  

• HP Z4   

• Lenovo P520 

Additionally, smaller platforms (desktop and laptop) in the 'workstation' ranges from 
the above manufacturers have shown to perform well in light geoscience workflows 
or with very small datasets:  

• HP Z1 all-in-one workstation series 

• HP Z240 desktop workstation series 

• Lenovo P310 desktop workstation series 

• Dell 3510 mobile workstation 

Note: Although the hardware listed here has been tested, it is not certified for use 
by Schlumberger. Problems beyond the control of Schlumberger (for 
example, driver bugs, BIOS bugs, operating system limitations) may affect 
individual experiences. 
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Petrel Geophysics Recommendations 

If you use the Geophysics module to view large 2D lines and 3D surveys and if you 
use the volume rendering feature, Schlumberger recommends that you use: 

• A high-end graphics card with at least 4 GB memory (refer to Table 3-8) 

• As much memory as your hardware and operating system permits and at least 
32 GB RAM 

Table 3-8 Petrel Geophysics Graphics Cards 

Levels Graphics Card 

High NVIDIA Quadro P6000 or P5000 

Medium  NVIDIA Quadro P5000 or P4000 

Minimum  NVIDIA Quadro P4000 

For better performance, use multiples of serial-attached SCSI (SAS) 15K RPM, SSDs 
or PCIe based flash. Consider: 

• Storage capacity (for example, 500 GB) 

• Rotational speed (for example, 15K RPM) 

• Interface (SATA, SAS, PCIe) 

Table 3-9 lists setup scenarios for Petrel Geophysics. 

Table 3-9 Petrel Geophysics Graphics Card Setup Scenarios 

Operating 

System 
RAM 

Graphics Card 

RAM 

Seismic 

Texture Cache 
Seismic Cache 

Seismic Interpretation 

64-bit system 
(Windows 7 
with SP1 or 
Windows 10) 

32 to 96 GB 1.5 to 4 GB 768 MB to 3 
GB depending 
on graphics 
RAM 

Up to 180 GB, 
depending on 
RAM 

Seismic and Geobody Interpretation 

64-bit system 
(Windows 7 
with SP1 or 
Windows 10) 

32 to 192 GB 4 to 8 GB 2 to 4 GB Up to 180 GB, 
depending on 
RAM 
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Network Storage Recommendation 

Petrel projects and associated data may be stored on a network drive on a central 
file server. Often, access to these projects could become a performance issue due to 
network congestion or as a result of using an inadequate Windows network protocol.  

To efficiently access project data stored on a network shared drive, use the Windows 
SMB2 or SMB3 network protocol. These protocols are available by default for 
Windows 7 and 10. Your network storage system must be able to support this 
protocol. Contact your storage provider if you need assistance. 

The combination of the 64-bit Windows operating system with the SMB2 protocol 
can significantly enhance Reference Project workflows and access to Petrel data, in 
general. 
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Remote Visualization Support 

Overview 

Many organizations are moving to a centralized application delivery model using thin-
client technology. Petrel can be used in this way if the environment is properly 
configured to meet application and workflow requirements. 

Schlumberger IaaS (Infrastructure as a Service) is the SIS-supported solution for 
E&P application centralization and provides a full, dedicated infrastructure designed 
to provide optimal performance for SIS Platform technologies. The solution provides 
an end-to-end service option for customers. 

Other solutions may work as well but are not supported. For customers 
implementing an internally developed converged infrastructure solution, we 
recommend validation of the specific solution through our Validation Framework 
service. This service helps define baseline performance characteristics and 
expectations of the environment. Please contact your account manager for further 
information on the validation framework service.  

Schlumberger IaaS (Infrastructure as a Service) 

Schlumberger IaaS provides a full E&P computing environment as a converged 
infrastructure, including systems, storage and networks. Extensive validation testing 
has been conducted to ensure the solution provides optimal performance† for SIS 
Platform technologies. The converged infrastructure approach means that the entire 
solution can be delivered as a managed service, taking the E&P workload off the 
shoulders of the internal IT organization. 

A full Schlumberger IaaS solution can be defined through a simple requirements 
assessment process and delivered to the customer pre-loaded with standard virtual 
images and Schlumberger software, including Petrel. 

If you are seeking to deploy Petrel in a centralized architecture, please contact your 
account manager for further information. 

† Bandwidth, latency and network quality can impact the quality and performance of 
visualization technologies. 
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Downloading the Installation Package 

The Petrel installation package is available on DVD or by download from the 
Software Download Center. 

Note: If you are a new user to the Software Download Center, you must register 
before you can download products. 

 To Download Petrel 2019 from the Software Download Center 

1 Go to www.sdc.oilfield.slb.com. 

2 Click Software Download Center. 

3 Log in to the site. 

4 On the Welcome Message page, click Continue. 

5 In the Product Group Name list (in the upper-left corner), click Petrel. 

The page updates to show all available Petrel downloads. 

6 Locate the Petrel 2019 package that you need and click the associated 
Download icon. You can download a full version or you can download a specific 
upgrade, extension, or plug-in. 

You are now ready to install Petrel 2019. 

http://www.sdc.oilfield.slb.com/
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Installing Petrel 2019 

Petrel 2019 is a complete package installation. Installation requires: 

• A workstation that is running a supported operative system. 

• At least 5 GB of free disk space in the installation directory to install Petrel  

• 3 GB on the C: drive for system files 

• Administrator rights on the local system 

You can install Petrel 2019 on a system that already has previous versions of Petrel. 
However, if you want Petrel 2019 only, you must uninstall the older versions (refer to 
“Uninstalling Petrel” on page 4-12). 

Note: If you plan to install a future version of Petrel that includes plug-ins such as 
Production or Drilling, refer to the plug-in release notes for an installation 
overview and steps on verifying the installation. 

 To Install Petrel 2019 

1 Insert the DVD or navigate to the location where you downloaded the installation 
files. 

2 In the DVD browser, from the root folder, run PetrelPlatformInstaller.exe.  

The License Terms & Conditions panel appears. 

3 On the License agreement panel, read the agreement, select I accept the 
terms in the license agreement, and then click Next. 

4 On the Prerequisite Check panel, inspect warnings or errors by hovering over 
the icon and then click Next.  

Read the Petrel Installation Guide for additional details. For optimal performance, 
all checks should show a green check mark.  

5 On the Destination Folder panel, accept the default folder, or click Change to 
select the folder where you want to install Petrel, and then click Install. 

Note: You must install Petrel on a local drive (a drive that is locally installed on 
your system). Please read the next section for the deployment of Petrel on a 
network-shared disk. 

6 When the installation completes, click Finish. 
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INTERSECT Connector 

Contrary to earlier Petrel releases, with Petrel 2019, you do not need to choose the 
INTERSECT connector version during Petrel installation. Instead, multiple INTERSECT 
connectors will be installed simultaneously and you can select the INTERSECT 
connector you want to use in Petrel by accessing File>Options>Select INTERSECT 
Connector. Switching the connector only takes effect when Petrel is restarted. Petrel 
stores the selection details in the following file:  

%APPDATA%\Schlumberger\Petrel\2019\IntersectConnector.xml 

Configuring the default INTERSECT Connector 

By default, the latest commercial version of INTERSECT connector is active the first 
time Petrel is started. System administrators can define a different default 
INTERSECT connector prior to roll-out. This can be configured by creating an 
IntersectConnector.xml file in Extensions\Schlumberger\INTERSECT subdirectory of 
the Petrel 2019 installation directory. For example: 

C:\Program Files\Schlumberger\Petrel 

2019\Extensions\Schlumberger\INTERSECT\IntersectConnector.xml 

The xml file must contain the following: 

<IntersectConnector> 

<intersect>INTERSECT version</intersect> 

<iscommercial>True/False</iscommercial> 

<override>True/False</override> 

</IntersectConnector> 

For example, to define 2018.1 INTERSECT Connector as the default, you can specify 
the following: 

 <IntersectConnector> 

<intersect>2018.1</intersect> 

<iscommercial>True</iscommercial> 

<override>False</override> 

</IntersectConnector> 

override =True/False: If set to False, the users will not be able to change the 

INTERSECT connector through the Select INTERSECT Connector dialog box in Petrel. 

iscommercial = True/False: Petrel will always attempt to load the latest 

commercial connector corresponding to the specified INTERSECT version. The 
iscommercial setting controls the behavior when no matching commercial 

connector is found, and a matching pre-commercial connector is available. If set to 
True, the pre-commercial connector will not be loaded. If set to False, the pre-

commercial connector will be loaded. 
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Default SLB plugins 

The Petrel Installer now installs any plugins that reside in the Plugins folder of the 
Petrel distribution (you can add others to this folder). These are currently: 

• GPM 

• GRM 

• RokDocQI 

• Well Spreadsheet Loader 

It will install each in turn and write the plugin install log in %temp% alongside the 
main installer log. If the plugin install fails, an error message is displayed in the 
installer GUI. 

The plugins appear in the Plug-in Manager; however, they cannot be disabled or 
uninstalled from the Plug-in Manager. 

 

All these plugins can be disabled using the command line format: 

C:\Program Files\Schlumberger\Petrel 2019>PluginManager.exe 

/disable /allusers ‘PluginID’ Petrel.exe 

Where ‘PluginID’ can be found using the command line format: 

C:\Program Files\Schlumberger\Petrel 2019>PluginManager.exe 

/list Petrel.exe 

‘PluginID’ is the second attribute in any line returned by the list command – 
examples highlighted below: 
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All the plugins can be uninstalled from Control Panel under ‘Uninstall a program’. All 
the plugins can also be uninstalled using the command line format: 

<C:\Program Files\Schlumberger\Petrel> 2019>PluginManager.exe 

/uninstall /allusers ‘PluginID’ Petrel.exe 

MSI packages for the default plugins are available in the Plugins folder of the Petrel 
distribution for those running scripted installations (see also Knowledge Base Content 
ID 6969918). 

 

 

 
  

https://www.software.slb.com/support/library/kbarticles/kb6969918
https://www.software.slb.com/support/library/kbarticles/kb6969918
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Deploying Petrel on a Network Shared Disk 

Overview 

This section explains how a system administrator can deploy Petrel 2019 on a 
network shared disk. 

Deploying Petrel 2019 on a network shared disk offers these advantages: 

• Easy and efficient deployment of Petrel 

• Single configuration file for all Petrel users 

• Transparent configuration and installation of updates for all Petrel users 

Deploying Petrel on a network shared disk reduces the management burden for 
system administrators. They can install, configure, and maintain the application in 
one location only. 

Also, the system administrator can configure a single Petrel configuration file to 
standardize license packages and specific Petrel settings for all Petrel users. For 
detailed information, refer to Appendix A, “Create a global configuration file to 
standardize system settings” on page A-3. Please see Section 6 on how to deploy 
plug-ins from a network shared disk. 

Deploying Petrel 2019 

Before beginning this procedure, you must be familiar with installing Petrel and you 
must already have access to a functional Petrel license.  

Note: A system administrator must perform this procedure. Petrel users cannot 
launch Petrel 2019 directly from the network path where the distribution 
resides. Petrel users must map the network shared folder on their local 
workstation.  

1 From the workstation, install Petrel 2019. 

2 Copy the entire installation folder where Petrel 2019 was installed (for example, 
C:\Program Files\Schlumberger\Petrel 2019) from the local 

workstation to a folder on the network shared disk (for example, P:\Global 

Petrel\Petrel 2019). 

On each workstation that will run Petrel, complete these steps: 

1 Go to the location on the shared disk where Petrel was copied and create a 
shortcut for the Petrel executable. Place the shortcut on the desktop. 

2 Install all the applications from the RuntimeEnvironment folder (which is 
located in the Petrel Installation folder) if they are not already installed on the 
workstation: 

• NDP452-KB2901907-x86-x64-AIIOS-ENU.exe 

• Windows6.1-KB2533623-x64.msu 

• vcredist_x64.exe  

• vcredist_x86.exe 
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• vcredist_2008_ATL_x86.exe 

• SQLSysClrTypes.msi (only to connect to Studio Database on SQL server) 

3 Execute the caspol.exe command to configure the runtime security policy for 
the machine. Here is an example of a script you can modify for your use. 

%windir%\Microsoft.NET\Framework64\v4.0.30319\caspol.exe -quiet  

-machine -reset  

%windir%\Microsoft.NET\Framework64\v4.0.30319\caspol.exe -quiet  

-enterprise -reset  

%windir%\Microsoft.NET\Framework64\v4.0.30319\caspol.exe -quiet  

-machine -addgroup 1 -url "file://\\your.server.com\Global 

Petrel\Petrel2019\*" FullTrust -name "Petrel_fulltrust"  

-description "Allow exe and dll from directory on Network drive to 

run with full .NET trust, necessary for calling native code."  

%windir%\Microsoft.NET\Framework64\v4.0.30319\caspol.exe -quiet  

-enterprise -addgroup 1 -url "file://\\your.server.com\Global 

Petrel\Petrel2019\*" FullTrust -name "Petrel_fulltrust"  

-description "Allow exe and dll from directory on Network drive to 

run with full .NET trust, necessary for calling native code." 

Modify \\your.server.com\Global Petrel\Petrel2019\ for your own 
environment. 

Executing the caspol command updates system security at the machine and 
enterprise policy level. This allows .exe and .dll files on the shared folder to run 
Petrel 2019 with full .NET trust. 

Resetting the policies removes existing policies that may have been configured at 
the site. Use caution when you reset a policy 

4 Launch Petrel 2019 from the shortcut that you created. 

5 Define the license server environment. 

 

Note: When running Petrel from a network shared disk performance is affected 
depending on network latency. Network shared installations cannot benefit 
from the Petrel startup optimization and caching, which has an impact on the 
Petrel startup performance.  
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Petrel Coordinate System Manager  

Installing Petrel 2019 also installs the Petrel Coordinate System Manager. The Petrel 
Coordinate System Manager enables you to manage and customize the Petrel 
Coordinate Reference System catalog.  

A geodetic expert can use the Petrel Coordinate System Manager to manage and 
customize the enterprise and extension catalogs used by Petrel. These catalogs 
provide the coordinate reference systems that are available in Petrel in the 
Coordinate reference system selection dialog box. From the Coordinate 
reference system selection dialog box, a Petrel user can select the appropriate 
coordinate reference system for a Petrel project. 

If the default catalog has not been changed, Petrel can be upgraded directly from 
Petrel 2010.1 to Petrel 2017.x.  

If the default catalog has been customized or replaced, a migration must be 
performed in order to make the customizations available in Petrel 2017.x.  

For more information about the Petrel Coordinate System Manager, refer to the 
Petrel 2019 Coordinate System Manager Online Help. 

Migrating 2015.1 Catalog Files 

If you used Petrel Coordinate System Manager 2015.x to customize the enterprise or 
extension catalog, you can migrate these catalogs to the 2016.1 catalogs that are 
used by Petrel Coordinate System Manager 2016.x and 2017.x.  

• If you stored the 2015.1 enterprise or extension catalog in the default location 
%APPDATA%\Schlumberger\Petrel\CRSCatalogConfiguration\2015.1, the 

software migrates the catalogs for you.  

• If you stored the 2015.1 catalogs in another location, for example, on a shared 
network drive, or if you want to migrate older catalogs, for example, 2013.1 
catalogs, you must manually enter the catalog locations in the 
CoordinateCatalogConfiguration.xml file before you can open Petrel 
Coordinate System Manager 2017.x or the Coordinate reference system 
selection dialog box in Petrel 2017.x.  

 To Migrate 2015.1 Catalog Files 

1 Navigate to the xml directory in your Petrel 2019 installation directory and open 
the CoordinateCatalogConfiguration.xml file. For example, C:\Program 

Files\Schlumberger\Petrel 2019\xml. 

2 Locate the section <!--Look-up path to previous catalogs --> and 

update the default enterprise and extension catalog file locations. For example, if 
you migrate 2015.1 catalogs, enter the location of the 2015.1 catalog files.  

a. To update the enterprise catalog file location, update this value with catalog 
file location: 

<Catalog name="CopyFromEnterpriseCatalog">        

<value>%APPDATA%\Schlumberger\Petrel\CRSCatalog 

Configuration\2015.1\CoordinateCatalogEnterprise.ctl 

</value> 

</Catalog>  
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b. To update the extension catalog file location, update this value with the 
catalog file location: 

<Catalog name="CopyFromUserdefinedExtensionCatalog"> 

<value>%APPDATA%\Schlumberger\Petrel\CRSCatalogConfiguration 

\2015.1\CoordinateCatalogExtensions.ctl</value> 

</Catalog>  

3 Save and close the configuration file.  

4 Migrate the catalogs by performing one of these actions:  

• Launch Petrel Coordinate System Manager 2017.x.  

• Launch Petrel 2017.x and open an existing Petrel project or create a new 
one. 

Re-migrating Catalog Files from Older Versions 

Catalog files from previous versions (prior to 2015.1) are not automatically migrated. 
You must manually migrate them by modifying the 
CoordinateCatalogConfiguration.xml file (refer to “Migrating 2015.1 Catalog 
Files” on page 4-9).  

However, as an example, if you opened the Petrel Coordinate System Manager or 
the Coordinate reference system selection dialog box in Petrel before you migrated 
your older catalog files, for example, your 2013.1 catalog files, you can use this 
procedure to re-migrate your older catalog files to 2016.1.  

Note: You can also use this remigration procedure if you opened Petrel Coordinate 
System Manager or the Coordinate reference system selection dialog 
box before you modified the CoordinateCatalogConfiguration.xml file 
with the location of your older catalog files stored on a network shared drive. 

 To Re-migrate Catalog Files from Older Versions 

1 Delete the default location for the 2016.1 catalog files that are used by Petrel 
Coordinate System Manager 2017.x: 

 %APPDATA%\Schlumberger\Petrel\CRSCatalogConfiguration\2016.1  

2 Navigate to the xml directory in your Petrel 2017.x installation directory and 
open the CoordinateCatalogConfiguration.xml file. For example, 
C:\Program Files\Schlumberger\Petrel 2017\xml.  
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3 Locate the section <!--Look-up path to previous catalogs --> and 

update the default enterprise and extension catalog file locations.  

a. To update the enterprise catalog file location, update this value with the 
location of your catalog file from an older version, for example, 2013.1: 

<Catalog name="CopyFromEnterpriseCatalog"> 

<value>%APPDATA%\Schlumberger\Petrel\CRSCatalogConfiguration 

\2013.1\CoordinateCatalogEnterprise.ctl</value> 

</Catalog>  

b. To update the extension catalog file location, update this value with the 
location of your catalog file from an older version, for example, 2013.1: 

<Catalog name="CopyFromUserdefinedExtensionCatalog"> 

<value>%APPDATA%\Schlumberger\Petrel\CRSCatalog 

Configuration\2013.1\CoordinateCatalogExtensions.ctl</value> 

</Catalog>  

4 Save and close the configuration file.  

5 Migrate the catalogs by performing one of these actions:  

• Launch Petrel Coordinate System Manager 2017.x.  

• Launch Petrel 2017.x and open an existing Petrel project or create a new 
one. 
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Uninstalling Petrel 

You can uninstall Petrel from the Control Panel. 

 To Uninstall Petrel from the Control Panel 

1 Click Start > Control Panel > Uninstall a program.  

2 In the list of currently installed programs, select the Petrel application, and then 
click Uninstall. 

Notes: • The installer detects installed Ocean plug-ins and uninstalls the plug-
ins before uninstalling Petrel. 

• If Ocean plug-ins were installed on a shared network disk, you may 
need to uninstall each plug-in separately before uninstalling Petrel, 
depending on how the plug-ins were initially installed. 
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5 Petrel License Selection 
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Licensing Introduction 

Petrel uses FlexNet-based licensing. This requires a continuous connection to a USB-
based CodeMeter dongle that serves licenses through a remote- or local-license 
server. To use a local license, you must have the Schlumberger Licensing tool and 
CodeMeter runtime installed. Both of these tools come with Petrel. 

Note: Petrel 2019 requires a 2017 version of the Schlumberger Licensing Tool, 
which is shipped with Petrel. The 2017 version of the Schlumberger 
Licensing Tool is fully backwards compatible with previous Petrel versions 
and does not require new license files. An error message is issued in the 
Petrel license selection dialog when connecting to the license sever through 
the 2015 Schlumberger Licensing Tool. For more information, please see the 
Schlumberger Licensing User Guide. 

As a minimum, Petrel requires a core module license. Petrel supports six core module 
licenses: 

• Geoscience core 

• Reservoir engineering core  

• Combined core (combines Geoscience core and Reservoir engineering core) 

• Shale core 

• Geophysics Core 

• Data and results viewer core 

• Ocean framework (enables Ocean development) 

Each core module license enables a different set of Petrel features.  

Core module licenses are offered in two types: 

• License bundle or  

• Stack on start  

(The Shale core is available as a license bundle only.) 

Petrel supports either license type in a standalone mode or mixing license types from 
multiple or a single license server provided through multiple or a single license file. 

This section describes the license types, license selection, setup, and configuration. 

Note: When choosing your license type and license feature sets, consult your local 
SIS Account Manager or SIS Services team for guidance on an optimal 
configuration. 
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Licensing Terminology 

License bundles (packages) 

A license bundle is a physical license. It must contain a Petrel core license and it may 
contain optional Petrel module licenses. Checking out a bundled license feature 
checks out all the licenses that the bundle contains. 

In the Petrel E&P Software Platform 2019 - License selection dialog box, by 
default, license packages are listed under Core licenses as Bundle + #. 

Stack on start (SOS) 

A stack on start (SOS) license consists of individual licenses for each Petrel module. 
SOS licenses can be part of the same license file or exist as separate license files.  

In the Petrel E&P Software Platform 2019 - License selection dialog box, 
Petrel core module SOS licenses are listed under Core licenses. All other Petrel 
modules are listed under Petrel modules. If multiple servers are connected, 
licenses are summed. 

Profiles 

A profile is a user-defined selection of licenses. This feature in Petrel allows you to 
check out a preselected set of licenses at startup. 

License feature 

A license feature, as used in FlexNet, is the actual licensed module or bundle of 
modules (in the case of bundled Petrel licenses). 

Module 

A module is a set of Petrel functionality that is usually tied to a license feature. Petrel 
modules are listed in the Petrel modules section of the License UI. There are 
dependencies between Petrel modules that are automatically honored during 
selection. 

Expiry date 

Each license bundle has an expiry date that defines when the license expires. All 
features that are part of the bundle expire on the same expiry date defined in the 
license file. 

Each stack on start feature (increment) has an expiry date that defines when the 
feature license expires. Stack on start increments may have different expiry dates.  

Petrel shows an expiration warning before the license expires. 
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Maintenance date 

The maintenance date defines when the current maintenance contract must be 
renewed to obtain access to new Petrel releases. The maintenance date consists of a 
month and year. After the maintenance date passes, Petrel versions released after 
this date do not work until the maintenance date is renewed. 

Each license bundle and SOS license feature has a maintenance date.  

License Selection 

You can use the License selection dialog box to manage all aspects of license 
selection independently of the license type or server. In addition, you can use the 
License selection dialog box to create and maintain user-defined license profiles to 
match individual end-user profiles or workflows. For more details about using the 
License selection dialog box, refer to the relevant section in the Petrel online Help. 

 

Figure 5-1  License selection dialog box 
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Color-coded information, warning, and error messages are captured and displayed at 
the bottom of the License selection tab. multiple messages are stacked based on 
priority. For an overview of all messages, refer to the Message log pane in the 
License selection tab. 

 

Figure 5-2 License message log showing color-coded information, warning, and 
error messages 
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License Bundles 

When you use licensing bundling, you must check out the entire package bundle. 
Bundles must contain a Petrel core module. Individual modules cannot be selected or 
deselected from the bundle. Typically, you will have one or more package bundles 
with one or more seats of each package bundle. Checking out a bundled license 
enables all the functionality licensed by the modules that are part of the bundle. 

For example, suppose you have purchased a single Petrel user license that consists 
of a Geoscience core, a Reservoir engineering core, and a set of Petrel modules 
(for example, Seismic interpretation, Facies modeling, etc.). Once the license file is 
generated by Schlumberger Information Solutions and installed at your site, when 
you log in to Petrel, the License selection dialog box opens. 

If additional Ocean licenses are available, they are listed under the Ocean modules 
section and can be selected or deselected as needed. 

Figure 5-3 shows multiple license bundles with Bundle 7 selected. You can view the 
contents of a bundle by expanding it in the right pane.  

 
Figure 5-3  License bundles 
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Stack on Start 

When you start Petrel with a stack on start license file, you can choose the Petrel 
core and module licenses that you want to use. Your selections become the stack of 
modules checked out and used during your Petrel session. The modules remain 
checked out throughout the session until you log off.  

In the License selection dialog box, the dependencies between Petrel core licenses 
and Petrel modules are explicitly mapped. This ensures that you can select valid 
module combinations only. 

If additional Ocean licenses are available, they are listed under the Ocean modules 
section. These licenses can be selected or deselected as needed. 

Figure 5-4 shows multiple Core licenses with the Geoscience core license 
selected. You can view the available Petrel module licenses by expanding Petrel 
modules in the right pane. You can select and deselect stack on start licenses as 
needed during your Petrel session. The Petrel modules node also provides a right-
click Select All option for quickly selecting all listed module licenses. 

 

Figure 5-4  Stack on start licenses 
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Mixing Bundles and Stack on Start Licensing 

Petrel 2019 supports the ability to connect to servers that provide both stack on start 
and bundled licenses. This allows you to mix bundles and stack on start licenses.  

Any additional Ocean licenses that are available are listed under the Ocean modules 
section. You can select or deselect these licenses as needed. 

 

Figure 5-5 Mixing bundled and stack on start licenses 

Figure 5-5 shows an example where the UI received licenses from a stack on start 
and bundled licenses server. In this example, the user selected Bundle 7, which 
represents the Shale bundle. The content of the Shale bundle can be inspected by 
unfolding the Bundle 7 node in the right pane of the UI. The Shale bundle can be 
extended with additional features that (if the relevant stack on start licenses are 
present) are listed in the Petrel modules node.  

Mixing stack on start licenses with bundled licenses allows you to select basic 
bundles and extend them with specific features that may be available in fewer 
quantities.  
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Check Out SOS Licenses at Petrel Runtime 

Petrel 2019 provides the option to check out functional SOS license modules while 
Petrel is running. This enables easy access to additional functionality needed for the 
workflow at hand and avoids to exit and restart Petrel to select additional functional 
license modules.  

Notes: • A prerequisite for checking out additional licenses at Petrel runtime 
is that license modules must to be of type Stack on Start (SOS). 
License modules that are part of bundle licenses are not available for 
runtime checkout. The same applies to Ocean Plug-in licenses, which 
will be enabled with a later Petrel release. 

• It is not possible to connect additional license servers while Petrel is 
running. Additional licenses can only be added from the servers 
connected at startup. 

 

Figure 5-6 Checking out licenses at runtime 

To check out additional license at runtime, click File > License modules and click 
the boxes for further licenses in the License status dialog box. Already selected 
licenses are marked and disabled (shown in gray text). 
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License Profiles 

The license profiles feature replaces previous functionality that provided names for 
packages. To create a profile, select the combination of licenses that you need and 
save the selected combination as a profile with a name. 

 

Saved profiles are listed under Profiles. 

 

You can also perform these profile-related actions: 

• Select a profile as a favorite that denotes the profile with a yellow star. To 
remove the favorite, open Petrel and click File > License modules.  

• Save a new profile 

• Rename a profile 

• Delete a profile 

 

Configuring Global Petrel License Profiles 

Petrel supports global license profiles. To set up a global license profile add a path to 
the following setting in the PetrelConfiguration.xml file, which is located in: 

%appdata%\Schlumberger\Petrel\2019 

In the PetrelConfiguration.xml file, locate the following parameter: 

<GlobalLicenseProfileFilePath Value="" /> 

Insert the full path and filename to your global license profile file, i.e., 

<GlobalLicenseProfileFilePath Value="D:\Global Petrel 

Profiles\Profiles2019.xml"/> 

When using a global license profile the options to save, create, delete or favorite 
profiles are grayed out. Global license profiles supersede any local Profiles.xml file.  
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To create a global license profile launch Petrel and save all license configurations 
using the options in the License UI. This creates a file named Profiles.xml in 
%appdata%\Schlumberger\Petrel\2019 

Use this file as your global license profiles file, copy it to the desired location and 
update the path for the setting in the PetrelConfiguration.xml file.  

Updating Petrel Packages to Petrel 2019 Profiles and Copying Profiles between Petrel 
Versions 

With Petrel 2014, the Profile feature replaced the custom License package available 
in earlier releases of Petrel. To transfer license package configurations from Petrel 
versions prior to Petrel 2014, follow these steps (using version 2013 as the 
example): 

1 Go to %appdata%Schlumberger/Petrel/2019 and rename the 

PetrelConfiguration.xml file to PetrelConfiguration_orig.xml. 

2 Next, go to %appdata%Schlumberger/Petrel/2013 and copy the 

PetrelConfiguration.xml file to %appdata%Schlumberger/Petrel/2019. 

3 If you want to retain specific settings from the original Petrel 2013 
PetrelConfiguration.xml file, port them to the new file.  

As an alternative, you could copy only the PackageNames line from the Petrel 

2013 PetrelConfiguration.xml file to the Petrel 2019 
PetrelConfiguration.xml file. 

4 Start Petrel 2019. During startup, the Petrel 2013 defined packages are 
converted to Petrel 2019 profiles and stored in Profiles.xml in 
%appdata%Schlumberger/Petrel/2019. 

Copying Profiles between Petrel Installations 

Use this method to copy profiles between Petrel 2019 installations: 

1 Go to %appdata%Schlumberger/Petrel/Petrel 2019.  

2 Copy the Profiles.xml file and paste it in the 
%appdata%Schlumberger/Petrel/Petrel 2019 directory of the new 

installation. 

 

Note: If the profiles are not available from the license server, the License UI shows 
a warning message in the message log to let you know that the Profile could 
not be loaded because no licenses are available on the current server. 

Tooltips 

You can view detailed information about the functionality provided by a Petrel 
module in the License selection dialog box by hovering over the item. Figure 5-3 
shows an example.  

This helps you to decide whether the module contains the features for the work to 
be executed and thus helps you to make the right selections.  
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License module expiry dates can be visualized in the tooltip by enabling the Show 
expiry date in license description option in the license settings tab of the license 
selection dialog.  

Customers are able to add custom description to the license module tooltip using a 
custom description xml file enabled through a PetrelConfiguration.xml file. See 
the Petrel online Help on how to enable this option.  

License information inside Petrel 

To access license information within Petrel, select File > License modules. The 
dialog provides this license feature information for the licenses in the currently 
available profiles. Select a profile and then select the license module in the list shown 
in the right pane. 

• Feature Name 

• Expiry date 

• Days Left 

• Server ID 

In addition the License module dialog to inspect the current selection and check out 
additional licenses for this selection.  

Note: Upon starting Petrel the next time, licenses added at runtime are not 
preserved in the current selection of profile. 
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Setting Up the License Server Environment 

Different license server environments are supported for different requirements. 
Petrel supports local servers, remote servers, and Quorum server configurations. 
Remote servers or Quorum server configurations are also supported on virtual 
windows systems using a USB network connector. However, any mentioned solution 
requires a dongle.  

License servers can host both bundle and stack on start licenses simultaneously. 

Note: Detailed information about setting up license servers, quorum servers, and 
troubleshooting can be found in the Schlumberger Licensing User Guide, 
located in the Documentation folder of the downloaded and extracted 
installation files. For more advanced license server configurations involving 
virtual or quorum setups, it is recommended to involve SIS services to help 
design a tailored system providing maximum performance and minimum IT 
maintenance. Contact your local account manager for more information. 

Connecting License Servers 

Local License Server Environment 

When using a local dongle, the local system must be configured to serve as a license 
server. In this case, the Schlumberger licensing utility and the CodeMeter dongle 
software must be installed. Both are distributed with Petrel and can be found in the 
unzipped Petrel installation directory. These tools require Admin privilege to install. 
To achieve maximum performance, make sure the recommended versions of 
Schlumberger licensing software is installed.  

Remote License Server Environment 

When building a remote license server environment, it is important to consider that 
network latency impacts the license checkout time. Thus, it is critical that remote 
servers, independently of whether they are physical, virtual, or a Quorum setup, are 
well connected within the network. When serving a large number of users (500+ 
licenses), Quorum configurations usually offer better performance than single 
servers. However, specific knowledge and testing of the network infrastructure 
should always be considered and performed for larger license server setups.  

Best Practices for Setting up a License Server  

Checking out a license is a frequent task. When many users are running Petrel, the 
time to connect to a license server and select the correct license is significant. To 
have minimum nonproductive time, these tips may be considered: 

• Always make sure the recommended/latest licensing software is used. This 
includes the Schlumberger licensing utility and CodeMeter driver. For information 
about the licensing software, refer to the Petrel Installation Guide and 
Schlumberger Licensing User Guide. 

• Be sure that you are using the most recent type of dongle. To check, look at ID 
number imprinted on the dongle. Up-to-date dongles have IDs that begin with2-
xxxxxx. If the ID begins with 1-xxxxxx, contact your account manager to request 
a new dongle. The new dongle type delivers performance improvements over 
the old type and should therefore be preferred. 
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• Avoid connecting to multiple license servers, if possible. Adding multiple colon-
separated license servers to the license selection reads the available licenses 
from all connected servers and linearly increases the time to populate the license 
UI based on the number of license features served by each server. Using a 
license quorum is the exception. When using a quorum, the license selection 
should include all 3 servers separated by a comma, for example, 
27000@quorumServer1, 27000@quorumServer2, 27000@quorumServer3. 

• Where possible, use Favorites. Favorite license packages can be created in the 
license UI by saving license selections as license profiles and denote one as a 
favorite using the Favorite option.  

• Always use a static port, for example, 27000@server.com, which optimizes the 
communication with the license system. 

• Set TCP_NODELAY. FLEX sends data between the client and server using TCP/IP 
packets. By default, the TCP/IP stack buffers small packets (< 147 bytes in 
FLEX), known as Nagle´s algorithm, to coalesce a large number of packets 
before sending them across the network. This ACK delay (200 ms) results in 
artificially high latency times for small packets such as most FLEX licensing 
operations. For this reason, we recommend disabling the Nagle algorithm by 
defining the TCP_NODELAY system setting as a license server environment 
variable to overcome this behavior, and reduce the licensing wait period. For 
more information read the Flexera documentation.  

• Use one license file only. Combining all licenses into one physical file improves 
communication with the license server and by eliminating the need to open and 
close multiple files to read license information.  

• Validate through the codemeter control center that the certified time is close to 
the current time. Navigate to Codemeter control center > File >  
Webadmin > Content > CmContainer and if necessary, update the certified 
time.  
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Licensing Issues and Solutions 

Petrel does not detect license dongle after removal and reinsertion or after the 
computer wakes from sleep or hibernation 

Follow these steps: 

1 As a prerequisite, ensure that this software is installed on your system: 

• 2017 Schlumberger Licensing Tool 

• Latest CodeMeter drivers  

• Updated dongle firmware 

2 Start the Schlumberger Licensing Tool. 

3 Stop any license server that is running. 

4 In Windows, select Start automatically. 

5 Click Apply. 

6 In Petrel, select File > Advanced options. 

7 Make sure that Install CodeMeter detector is selected. 

 

8 Click OK. A service is installed to detect when a dongle is removed or inserted. 

9 Restart the License Server. 

10 Start Petrel. 

Note: If you switch between wireless and cable-based connections while Petrel is 
running or after hibernation, a reconnection with the license server may fail 
because of a network conflict.  
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Petrel disconnects from the license server or loses the license on a regular basis.  

Follow these steps: 

1 Upgrade CodeMeter to the latest version. 

2 Swap a new Petrel dongle. 

3 Update Petrel dongle Certified Time. 

4 Use a different USB port.  
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6 Plug-ins 
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Overview 

The Ocean Plug-in Manager enables you to access, organize, and manage plug-ins 
within Petrel. Plug-ins can come from a variety of sources. They may be: 

• Distributed from the Ocean Store (www.ocean.slb.com) 

• Developed internally within your company 

• Developed as third-party plug-ins 

The Ocean Plug-in Manager uses a Petrel plug-in installer package (.pip) for 
packaging and distributing plug-ins. You do not need to run an installer application 
to install or uninstall a plug-in. 

From the Ocean Plug-in Manager, you can access plug-ins from two locations: 

• Plug-ins published in the Ocean Store 

• Plug-ins developed by your own organization and available on your network 

The information in this chapter is for system administrators. This chapter tells you 
how to customize the deployment of plug-ins and how to customize the Ocean Plug-
in Manager interface to enable or disable features. 

Installing and Uninstalling Plug-ins 

Ocean for Petrel is a public, open API that sits on top of Petrel. You can use Ocean 
for Petrel to develop plug-ins that extend Petrel capabilities. 

Each plug-in includes its own installer and targets a specific version of Petrel. When 
a plug-in is installed, it registers itself to let Petrel know that it exists and also to 
provide information on how it can be uninstalled. If the plug-in is uninstalled, it 
unregisters itself from Petrel. 

If you uninstall Petrel, Petrel checks for plug-ins and prompts you to uninstall the 
registered plug-ins. Uninstalling all plug-ins is recommended if you uninstall Petrel.  

Plug-in Licenses 

When you order a Petrel plug-in from the Ocean Store, full instructions for installing 
and activating the plug-in license are included in the email that is sent to you. You 
can also find this information on the Ocean Store’s Help page. 



    

Plug-ins   6-3 

Schlumberger Private - Customer Use 

Plug-in Manager  

Plug-in Manager Settings 

The Petrel.exe.config configuration file contains the Ocean Plug-in Manager 
settings. You can find Petrel.exe.config in the Petrel installation folder. For 
example: 

C:\Program Files\Schlumberger\Petrel 2019\Petrel.exe.config 

Note: Back up the Petrel.exe.config file before editing. 

Customizing the Plug-in Manager interface 

Follow these steps to customize the Plug-in Manager interface. 

 To Customize the Plug-in Manager Interface 

1 If Petrel is open, close it. 

2 Open the Petrel.exe.config file. 

3 Find the <configSections> tag and add this section, if it is not there: 

<sectionGroup name="applicationSettings" type="System. 

Configuration.ApplicationSettingsGroup, System, Version=4.0.0.0, 

Culture=neutral, PublicKeyToken=b77a5c561934e089"> 

<section name="Slb.Ocean.Petrel.PluginManagerUiElements. 

Properties.Settings" 

type="System.Configuration.ClientSettingsSection, System, 

Version=4.0.0.0, Culture=neutral, 

PublicKeyToken=b77a5c561934e089" requirePermission="false"/> 

</sectionGroup> 

This code enables configuration settings under a separate <application 

Settings> tag. 

4 Inside the <configuration> tag, on the same level as the <configSections> 

tag, add this section if it is not there: 

<applicationSettings> 

   <Slb.Ocean.Petrel.PluginManagerUiElements.Properties.Settings> 

   </Slb.Ocean.Petrel.PluginManagerUiElements.Properties.Settings> 

</applicationSettings> 

5 Inside the <Slb.Ocean.Petrel.PluginManagerUiElements. 

Properties.Settings> tag, add the settings you want to modify. Use this 

format: 

<setting name="SettingName" serializeAs="Type"> 

    <value>Value</value> 

</setting> 
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For example: 

<setting name="StoreTabEnabled" serializeAs="String"> 

<value>True</value> 

</setting> 

6 Use this same format to change these additional Plug-in Manager settings: 

• StoreTabEnabled: Set as True if you want the Plug-in Manager’s Store 

section enabled. 

• SecurityTabEnabled: Set as True if you want the Plug-in Manager’s 

Security section enabled and visible. 

• CorporateTabEnabled: Set as True if you want the Plug-in Manager’s 

Corporate section enabled and visible. 

• InstallPluginButtonEnabled: Set as True if you want the Install Plug-

ins feature enabled in the Plug-in Manager. This feature is available only for 
plug-ins packaged with a Petrel plug-in installer package (.pip file). 

• UpdatePluginButtonEnabled: Set as True if you want the Update Plug-

in feature enabled from the Plug-in Manager. 

• AddTrustedPublisherButtonEnabled: Set as True if you want the 

Add Trusted Publisher feature enabled. 

• RemoveTrustedPublisherButtonEnabled: Set as True if you want the 

Remove Trusted Publisher feature enabled. 

• ChangeSecurityLevelEnabled: Set as True if you want the Change 

Security Level feature enabled. 

7 Save the file. 
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Deploying Plug-ins from a Network Shared Folder 

The Ocean Store is the designated website where scientists and engineers can 
access and download plug-ins to use with Petrel. Plug-ins developed by other 
companies for their internal use are not available in the Ocean Store. 

A system administrator can use the Ocean Plug-in Manager to configure the internal 
source for plug-ins (for example, network shared folders) to distribute and deploy 
plug-ins within Petrel. These plug-ins are available in the Corporate section of the 
Ocean Plug-in Manager. 

Note: The Ocean Plug-in Manager cannot browse plug-ins directly from the 
network path where the plug-ins reside. Petrel users must map to the 
network shared folder on their local workstation. 

 To Enable Deployment of Plug-ins from a Remote Folder 

1 If Petrel is open, close Petrel. 

2 Open the Petrel.exe.config file. 

3 Find the <configSections> tag and add this section, if it is not there: 

<sectionGroup name="applicationSettings" 

type="System.Configuration.ApplicationSettingsGroup, System, 

Version=4.0.0.0, Culture=neutral, 

PublicKeyToken=b77a5c561934e089"> 

<section name="Slb.Ocean.Petrel.PluginManagerUiElements. 

Properties.Settings" 

type="System.Configuration.ClientSettingsSection, System, 

Version=4.0.0.0, Culture=neutral, 

PublicKeyToken=b77a5c561934e089" requirePermission="false"/> 

</sectionGroup> 

This enables the configuration settings under a separate <applicationSettings> 

tag. 

4 In the <configuration> tag, on the same level as the <configSections> 

tag, add this section if it is not there: 

<applicationSettings> 

<Slb.Ocean.Petrel.PluginManagerUiElements.Properties.Settings> 

</Slb.Ocean.Petrel.PluginManagerUiElements.Properties.Settings> 

</applicationSettings> 

5 In the <Slb.Ocean.Petrel.PluginManagerUiElements. 

Properties.Settings> tag, make sure that this setting is set to True: 

<setting name="CorporateTabEnabled" serializeAs="String"> 

    <value>True</value> 

</setting> 

6 In the <Slb.Ocean.Petrel.PluginManagerUiElements. 

Properties.Settings> tag, add this section if it is not there: 

<setting name="LocalStoreDirectories" serializeAs="Xml"> 

<value> 

<ArrayOfString xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema">  

</ArrayOfString> 

</value> 

</setting> 

http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema


   

6-6   Petrel 2019 Installation Guide 

Schlumberger Private - Customer Use 

7 Inside the <ArrayOfString> tag, add the folder locations where Ocean plug-

ins can be located. You can add as many locations as you need. For example: 

<string>H:\Corporate Plug-ins</string> 

<string>D:\My Developed Plug-ins</string> 

<string>I:\Asset Team Plug-ins</string> 

<string>\\myServer\MyFolder</string> 

Notes: • Deploy your Ocean plug-in PIP files or assembly files into subfolders 
of the root folder configured in Petrel.exe.config. 

• Use PIP files for faster resolution of the plug-in list in the Corporate 
tab. 

• Plug-ins that are already installed locally will not show up in the 
Corporate tab. 

• You can use this procedure to set a local folder (for example, C:\my 
developed plug-ins) as the location of the plug-ins directory. 

1 Find the <runtime> tag and add this section: 

<loadFromRemoteSources enabled="true" />  

Note: Refer to the Microsoft Knowledge Base article 
http://msdn.microsoft.com/enus/library/dd409252(VS.100).aspx for more 
information about this setting. 

2 Save the file. 

3 From a DOS shell, run the caspol command to configure the machine’s runtime 
security policy. This command enables your system to trust the execution of .exe 
and .dll files from a network shared folder. 

a. Change to this directory: 

C:\Windows\Microsoft.NET\Framework64\v4.0.30319 

b. From this location, run caspol.exe: 

C:\Windows\Microsoft.NET\Framework64\v4.0.30319> caspol.exe -
quiet -machine -addgroup 1 -url "\\myServer\MyFolder\*" 

FullTrust -name "Petrel_fulltrust”  

-description "Allow_exe_and_dll_to_run_with_full_.NET_trust" 

You can run the caspol.exe command from a DOS shell, but make sure that you 
change \\myServer\MyFolder\* to the location where your plugin assemblies 

are. This location must be accessible when you execute the caspol command.  

The caspol command updates your system security at the machine policy level. 
You can find the security policy updates at:  

• %WINDIR%\Microsoft.NET\Framework64\version 

directory\config\Security.config 

• %WINDIR%\Microsoft.NET\Framework64\version 

directory\config\Security.config.cch  

http://msdn.microsoft.com/enus/library/dd409252(VS.100).aspx
file://///myServer/MyFolder/*
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Warning: Do not open these files you unless you are familiar with them. Incorrect 
changes to these files could make your system unstable. 

4 Repeat step 10 for each network shared folder that you want Ocean Plug-in 
Manager to browse for plug-ins. 
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Changing the Default [Plug-ins Home] Directory 

Plug-ins are usually deployed or installed in a directory under [Petrel Home] 

called \Extensions (for example, C:\Programs Files\Schlumberger\Petrel\ 

2019\Extensions). This folder is considered the default [Plug-ins Home] 

directory. 

 To change the default location of the [plug-ins home] directory 

1 If Petrel is open, close Petrel. 

2 Open the PluginManagerSettings.xml file. 

Find the <DefaultDirectory> tag (for example, <DefaultDirectory 
Name="Default" Location="C:\Program Files\Schlumberger\ 

Petrel 2019\Extensions\" />). 

3 Enter the address for the new [Plug-ins Home] location (for example, 
<DefaultDirectory Name="Default" Location="D:\My Documents\ 

My Plug-ins\" />). 

Notes: • You must have read/write access to the new [Plug-in Home] 

directory. 

• The [Plug-in Home] directory may be located on a network 

shared folder. The system administrator must execute the caspol.exe 
command to configure the machine runtime security policy (refer to 
“Deploying Plug-ins from a Network Shared Folder” on page 6-5 for 
more details). 

4 Save the file. 

Warning: Plug-ins that use installers for deployment may be deployed under 
[Petrel Home]\extensions. Only plug-ins deployed or installed 

from the Plug-in Manager are guaranteed to be deployed automatically 
in the customized [Plug-in Home]. 

 

Note: There is a known issue when installing plug-ins into a restricted folder 
structure. For more information, refer to “Plug-in Issue and Solution” on 
page A-6. 
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What is the Petrel Startup Optimization Option? 

The Startup Optimization setting runs a native image generator (Ngen) tool that 
improves the performance of managed applications. The installation process enables 
this setting by default.  

What is Ngen? 

Ngen is a Native image generator tool that improves performance of managed 
applications. Ngen.exe creates native images (files containing compiled processor-
specific machine code) and installs them into the native image cache on your local 
computer. The runtime executable uses these images from cache instead of using 
the just-in-time (JIT) compiler to compile the original assembly. 

How does it work? 

Ngen compilation is on by default. After Petrel is installed and your system is idle, 
Ngen begins to create native images and store them in a hidden directory 
(C:\Windows\assembly\NativeImages_v4.0.30319_64). This process is 

transparent; the system controls when to create the native images and when to use 
them.  

Never delete this directory. It contains many files; some belong to Petrel (these are 
identified by an .slb extension) and others belong to other applications. The files are 
removed when Petrel is uninstalled. 

Can I run Ngen manually? 

Yes. In order to run Ngen manually: 

1 Open a Command prompt and change to the Petrel installation directory. 
(Usually, this directory is C:\Program Files\Schlumberger\Petrel 

2019).  

2 To install: 

At the Command prompt, enter ngenrun.bat install  

3 To uninstall: 

At the Command prompt, enter ngenrun.bat uninstall  

Both the install and uninstall process take several minutes. 

Ngen significantly increases Petrel startup time. However, you must evaluate your 
own situation with your IT staff; in certain situations, startup optimization must be 
turned off. 
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Petrel Issues and Solutions 

Create a global configuration file to standardize system settings  

If you want to standardize Petrel 2019 system settings for multiple users, create a 
global configuration file. Petrel stores the user system settings in the 
PetrelConfiguration.xml file. The first time you run Petrel 2019 and exit, the file is 
created in the folder named %APPDATA%\Schlumberger\Petrel\2019. 

For Windows 7, the application data and settings folder is C:\Users\<username> 

\AppData\Roaming\Schlumberger\Petrel\2019. 

The PetrelConfiguration.xml file contains this information: 

• Settings configured in the Select license package window, such as package 
name and favorite package 

• Settings configured using File > System > System Settings.  

Note: If you change these settings, the changes are stored in the 
PetrelConfiguration.xml file each time you exit Petrel. 

For more information, refer to “System Settings” in the Petrel online Help. 

 To Create a Global Configuration File 

Note: A system administrator or license administrator must perform this procedure. 

1 Open Petrel. 

2 Configure your license packages in the Select license package dialog box. 

3 Configure your system settings in Petrel. 

4 Close Petrel. 

Your PetrelConfiguration.xml file is updated with the settings that you 
selected, and it is ready to be distributed globally.  

5 Copy the PetrelConfiguration.xml file to a shared disk drive that all users can 
access, and set it to read only.  

Remove these lines from the global configuration file: 

<UseGlobalSettingsFile Value="True"/> 

<GlobalSettingsFile Value=""/> 

6 To enable Petrel users to use the global configuration file, you need to set their 
local configuration file to point to the global PetrelConfiguration.xml file. 
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Make a copy of the PetrelConfiguration.xml file created in Step 5 and remove 
everything from the file except these lines: 

<?xml version="1.0" encoding="us-ascii" standalone="no" ?> 

<Configuration> 

<SystemSettings> 

<UseGlobalSettingsFile Value="True"/> 

<GlobalSettingsFile Value="E:\PetrelConfiguration.xml"/> 

</SystemSettings>  

</Configuration> 

Important: For the GlobalSettingsFile Value, replace 
E:\PetrelConfiguration.xml with the path to the shared folder 

where you place your global configuration file. 

Copy the new PetrelConfiguration.xml file to the %APPDATA% folder on all 
Petrel user machines. Typically, you copy the new PetrelConfiguration.xml file to 
this default folder on Windows, which is 
C:\users\<username>\AppData\Roaming. 

When Petrel starts, Petrel uses the settings defined in the global configuration file 
(PetrelConfiguration.xml). After completion of the first Petrel run, a new 
PetrelConfiguration.xml file is created (if it does not exist) in the user data and 
settings location. This file is identical to the global configuration file. It allows 
individual users to personalize their own Petrel environment for an individual session 
without modifying anyone else’s settings. The settings in the global configuration file 
overwrite the personalized settings when Petrel is restarted. 

Users can also select the global configuration file in the Define license server 
environment window. Refer to “Deploying Petrel on a Network Shared Disk” on 
page 4-7 for more information about selecting the global configuration file. 

Lines can be deleted from the global configuration file, and only settings that 
correspond to the remaining lines in the global configuration file can be controlled 
globally. The user can control settings that do not have corresponding lines in the 
global configuration file. 

Failure messages when opening Petrel 

You may receive this error messages from the limited connection configuration in the 
file server that is serving the Petrel network folder: 

• “The application failed to initialize properly.” 

• “Required Petrel module failed.... Not enough server storage is available to 
process this command.” 

You must modify the server's IRPStackSize in the registry table. If the subkey is not 
present, use Registry Editor to add it. 

The IRPStackSize parameter specifies the number of stack locations in I/O request 
packets (IRPs) that are used by a Windows Server 2003 and a Windows XP server. 
You may need to increase this number for these transports: 
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• Media access control (MAC) drivers 

• File system drivers 

Each stack uses 36 bytes of memory for each received buffer. This value is set in this 
registry subkey:  

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet 

\Services\LanmanServer\Parameters 

The default value of the IRPStackSize parameter is 15. The range is from 11 (0xb in 
hexadecimal) through 50 (0x32 in hexadecimal). 

The Microsoft Support website has more information about this issue: 

• Article 285089: “Description of the IRPStackSize parameter in Windows 2000, in 
Windows XP, and in Windows Server 2003” 
(http://support.microsoft.com/kb/285089) 

Warning: This action should be performed by IT engineers or system 
administrators. Do not make any changes to the registry unless you are 
familiar with the Registry Editor. If you make a mistake, it may harm 
your computer. 

 To Add and Modify the Irpstacksize Subkey 

1 Select Start > Run. 

2 Type regedit, and then click OK. 

3 Select this subkey: 

KEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\ 

LanmanServer\Parameters 

4 Select Edit > New > DWORD Value. 

5 Type IRPStackSize (this value is case sensitive) and then press ENTER. 

6 Select Edit > Modify. 

7 In the Data Value field, type the value that is appropriate for the network and 
then click OK. 

If the problem persists after you complete this procedure, increase the IRPStackSize 
value more. 

0xc0150002 error message when opening Petrel 

You may receive a 0xc0150002 error if all necessary components are not installed. 

Make sure these components are installed on the workstation: 

• Visual C ++ libraries 

• Microsoft .NET Framework 4.0 

• Microsoft.VC80.MFC (64-bit) for a 64-bit workstation 
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Plug-in Issue and Solution 

Access denied during plug-in installation 

If you try to install a plug-in into a restricted location on your computer, the Plug-in 
Manager displays an Access Denied message. 

Plug-ins are usually deployed or installed in this directory: 

[Petrel Home]\Extensions 

For example: 

c:\Programs Files\Schlumberger\Petrel\2019\Extensions 

The [Petrel Home]\extensions directory is the default [Plug-ins Home] 

directory. If you receive an Access Denied message while installing a plug-in, the 
access to [Petrel Home] and/or [Plug-ins Home] is most likely restricted. 

To allow the Plug-in Manager to install plug-ins, change the default [Plug-ins 

Home] directory as described in “Changing the Default [Plug-ins Home] Directory” 

on page 6-8. 
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System Settings 

Hyperthreading 

Hyperthreading is an option that does not improve Petrel performance. Whether the 
option is ON or OFF has no impact on Petrel. If the option is turned ON for other 
reasons, be aware that this affects how Windows reports CPU utilization. 

 

Can I run the installation executable (PetrelPlatformInstaller.exe) from the command 
line? 

You can execute PetrelPlatformInstaller.exe from the Windows command line. 
The executable program supports these options: 

Option  Description 

/? or /Help Lists available commands 

/InstallFolder="C:\CustomInstallPath\" Identify the directory name for 
the installation 

/Silent /Install Install with no UI 

/Silent /Uninstall Uninstall with no UI 

A log file is automatically created for each installation and stored in the user’s 
%TEMP% directory.  

Can I deploy the Petrel E&P software platform 2019 without using 
PetrelPlatformInstaller.exe? 

Installing Petrel without using the PetrelPlatformInstaller.exe file is possible but 
not recommended and can lead to corrupted installation if attempted. Please contact 
your account manager for more information before creating a custom installer. 
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B Advanced Printing System (APS) 
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Overview 

Petrel uses the SDITM Advanced Printing System (APS®) for a plotting engine. With 
APS, Petrel provides native support for directly printing and exporting plot windows 
to .cgm and .pdf formats.  

APS’s integrated printing and plotting functionality provides these benefits: 

• Improved options for page scaling (fitting to a page) and orientation (portrait 
and landscape) 

• Support for large printers, with a thumbnail display for easy print orientation 

• Support for roll plotters without the need to specify custom page sizes 

• Options to generate .cgm and .pdf files directly from the Petrel Printing 
window 

• Automatic detection and configuration of the printer setup from existing 
Windows print drivers 

• Ability to produce large print jobs without the limits of the standard Windows 
GDI printing system 

Note: Petrel supports a large number of printers. For a full list, refer to 
www.sdicgm.com. 

http://teamspace.slb.com/sites/PetrelIT/InstallationGuide/Shared%20Documents/Working%20Versions/Petrel%202014.1/www.sdicgm.com
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Examples 

The measurements in this example show that the width of the selected file exceeds 
the width of the targeted media. Because the Tile check box is selected, the image 
width value is orange. Orange indicates that the image requires paneling and that 
Petrel can print multiple panels.  

 

In the next example, the Tile check box is unchecked and the width value is red. In 
this case, Petrel prints only the portion of the image that fits on the initial panel. 
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The next example shows the Page Scaling field using Width to unlock the image. 
When you select Width, Petrel automatically scales the image width to the 
maximum width of the media while maintaining depth scale. This gives depth 
accuracy while displaying the full width of the image.  

 

You can also specify scale values, which alter length and width dimensions by the 
same percentage. If you need a specific width or height, you can enter that value 
and APS will alter the other axis appropriately.  
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As the next example shows, you can export to a .cgm or .pdf file on the Petrel 
printing window. 
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C Studio Database Configuration  

In This Chapter 

Third-Party Software Configuration ..................................................................................... C-2 

Connecting to the Database ............................................................................................... C-3 

Automatic Connection to a Studio Repository ....................................................................... C-4 

Enabling the Remember Password Feature .......................................................................... C-5 

Changing the Configuration for Custom Coordinate Systems ................................................. C-6 
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Third-Party Software Configuration 

Single Sign On 

Single Sign On Configuration 

Configuring the Single Sign On authentication against Active Directory consists of 
three main procedures: 

1 Configure the Active Directory service account. 

2 Configure the Oracle database server. 

3 Configure the client. 

 To Configure the Client 

1 Create a krb5.conf file. 

2 Create Oracle net parameters (sqlnet.ora):  

• Add the following parameters to the sqlnet.ora file: 

SQLNET.AUTHENTICATION_SERVICES=(KERBEROS5PRE,NONE) 

• Add KERBEROS5 to any other authentication services that you are using. 

SQLNET.KERBEROS5_CONF=c:\oracle\network\krb5\krb5.conf  

• This parameter points to the krb5.conf file. 

SQLNET.KERBEROS5_CONF_MIT=TRUE 

SQLNET.KERBEROS5_CC_NAME=OSMSFT:// 

3 Create an environment variable named TNS_ADMIN with a path that points to 

the location of the sqlnet.ora file. 
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Connecting to the Database 

The first time you log in to Studio, you must have a connection to the database.  

For instructions about connecting to the database, refer to the appropriate 
documentation for your role: 

• Database user: Open the Petrel Help Center. Navigate to Studio > Studio 
Database > Accessing Studio Database > Managing Database 
Connections > Creating a Connection to a Database. 

• Database administrator: Open the online Help in Studio Manager. 
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Automatic Connection to a Studio Repository 

A Studio administrator can enable to automatically connect to the Studio repository 
for each Petrel workstation. If this option is enabled, when the Petrel project is 
opened, it will automatically reconnect to the last Studio repository that was 
accessed. This way, the Studio notifications, alerts, and synchronization workflows 
are immediately enabled, without having the Petrel user open a Studio dialog. 

This option can be enabled at the application level (and deployed to all the Petrel 
workstations if this is the company policy). 

A Petrel user can enable this option by clicking File > Project setup > Project 
settings > Studio settings > Repository settings. 

If the option is defined from Petrel, it will take precedence over the application level. 

The automatic connection is only available when connecting to a repository using 
Windows authentication with SQL Server or SSO with Oracle. 

 To Enable the Automatic Connection at the Application Level 

1 On the Petrel workstation, open the Slb.P4E.Dbx.Config file (in the Petrel 
installation directory, located at ...\Schlumberger\Petrel 

2019\Extensions\ Schlumberger\Studio). 

2 Look for ConnectionOptionsSection in the config file and set 

EnableAutoConnect to True. 

3 Save the file. 
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Enabling the Remember Password Feature 

A Studio administrator can enable the Remember password feature for each 
Petrel workstation. When enabled, a Remember password option appears in the 
Studio Login window. Selecting this option saves the user's password so that he or 
she does not need to log in when opening Studio. 

 To Enable the Remember Password Feature 

1 On the Petrel workstation, open the Slb.P4E.Dbx.Config file (in the Petrel 
installation directory, at ...\Schlumberger\Petrel 2019\Extensions\ 

Schlumberger\Studio). 

2 Set ProvideSavePasswordOption to True. 

The line is: 

<ConnectionOptionsSection ProvideSavePasswordOption= “false” /> 

3 Save the file.  
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Changing the Configuration for Custom Coordinate Systems 

Petrel provides coordinate reference systems from these standard authorities: 

• European Petroleum Survey Group (EPSG) 

• Esri©  

• Software Integrated Solutions (SIS)  

If your company’s geodesy group uses custom coordinate systems with internally 
developed codes, you can prevent your users from making changes to the standard 
authority coordinate reference systems, transforms, and conflation policies. 

Important: If you did not deploy Studio and you want to make these 
configuration changes, change the configuration of the Coordinate 
System Manager. If you did deploy Studio, change the configuration 
of Studio Manager. 

A flag in a configuration file controls this behavior. By default: 

• The flag for the Coordinate System Manager’s configuration file is set to True 

• The flag for the Studio Manager’s configuration file is set to False 

Table C-1 Comparison of the true and false flags 

AllowAdminOutOfBoxCatalog=True AllowAdminOutOfBoxCatalog=False 

Default flag for Coordinate System 
Manager 

Default flag for Studio Manager 

Can delete any coordinate reference 
system, transform, or conflation policy 

Cannot delete any coordinate reference 
system, transform, or conflation policy  

Can create any coordinate reference 
system, transform, or conflation policy, 
using any authority or code if there is 
no conflict with existing ones in the 
catalog 

Only can create coordinate reference 
systems, transforms, or conflation 
policies with Petrel as the authority 
(that is, Source=Petrel) and with a code 
that is within the designated ranges 

Can add a coordinate reference system 
or simple transform from the Esri 
catalog, using the code (for example, if 
a person deletes one and later wants to 
add it back) 

Cannot add a coordinate reference 
system or simple transform from the 
Esri catalog, using the code (because it 
cannot be deleted) 
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 To Change the Configuration 

1 Open the configuration file in a text editor: 

Did you deploy 
Studio? 

Open this file: 

No The Coordinate System Manager configuration file 
CoordinateSystemAdmin.exe.config 

Yes The Studio Manager configuration file 
StudioManager.exe.config 
Refer to the Studio Installation and Configuration Guide 
for the location of the file. 

 

2 In the ApplicationConfigurations section, change the flag for 
AllowAdminOutOfBoxCatalog to True or False. 

3 Save and close the configuration file. 
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D Enhanced Summary File Format 
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Overview 

The simulator output for summary results in the form of *.(F)SMSPEC and 
*.A/Sxxx files reflects the way the simulator solves the mathematical equations for 
increasing time. Accessing the data for a particular summary vector–usually for 
plotting against time–requires the entire data set. This access pattern is poorly 
supported by the simulator output mentioned previously, more so if the data is 
located on a network drive. In effect, accessing summary data often results in high 
access times over network connections. This is the primary motivation behind the 
introduction of a new, enhanced file format for storing summary data from Petrel 
2017 onward. Requesting summary data in this new file format results in greatly 
increased access speed over network connections. 

How does it work? 

The recommended workflow is to make the conversion to the enhanced summary file 
format part of the simulation submission job rather than through Petrel. For more 
information, refer to “Technical Details” and “General Considerations”, which contain 
information about performance and resource requirements. 

Conversion-related Worksteps in Petrel 

When you load a Petrel project, whether it is a legacy project or not, Petrel checks 
whether conversion is needed. If so, the conversion process to the new file format is 
started in the background without impeding Petrel itself. Names of individual cases 
being converted appear in red font with the addition (summary conversion being 
active...) as seen in the figure: 

 

Note: If the data is stored on a network location, do not access summary data for 
a case during the conversion. Although you can access the data, you do not 
benefit from increased summary data performance until the end of the 
conversion. 

If you decide not to use the enhanced summary file format for a particular case, 
open its settings dialog by right-clicking the case. Then select the Results import 
tab and clear the Use enhanced summary file format option, as shown in the 
figure: 
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Generally, Petrel ensures that the enhanced summary file format is being used and 
kept up-to-date. However, you have the option to enforce conversion by right-
clicking on a simulation case, case folder, or case collection and selecting Convert 
summary data into enhanced summary file format on the popup menu.  

 

If this option is disabled (displayed with gray text), Petrel either has not found any 
summary data for the case or the option selection has been cleared in the Results 
import tab on the case. 

The message log displays several messages that explain the process. 
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Technical Details 

Conversion into the enhanced summary file format can occur in one of two ways:  

1 As part for the simulation submission workflow 

After successfully completing the simulation, the conversion to the enhanced file 
format is triggered as a port-processing step before the results are loaded back 
into Petrel. This is the recommended workflow because it hides the conversion 
time. 

2 When importing the deck into Petrel or loading the results 

Petrel checks whether conversion is needed. In this case, the conversion takes 
place on the machine where Petrel is installed. Although the conversion is done 
without impeding Petrel, it is not recommended that you allow Petrel to do the 
conversion because it can be expensive in terms of resources needed (time and 
memory). 

The Preferred Workflow for Conversion 

Conversion from the simulator output for the summary results into the enhanced 
summary file format may take a considerable amount of time, depending on the size 
of the summary data, network speed, and the load on the machine Petrel is running. 
Therefore, you are advised to make the conversion process part of the simulation 
submission system. This section describes three different method for making the 
conversion part of the recommended post-simulation workflow.  

ECLRun >= 2012 

First consider ECLRun 2012, the first version of ECLRun aware of this new file 
format. If you submit a simulation run via ECLRun 2012, it triggers the simulation 
data conversion after successful completion of the simulation run. That means by the 
time the results are read back into Petrel, the enhanced summary file is already 
created so Petrel does not need to create it. You benefit from the advantages of this 
new file format immediately. 

You can control certain aspects of the conversion by editing the 
PetrelConfiguration.xml file. 

Note: Before changing this file, close all instances of Petrel; otherwise, you will lose 
your changes when you close Petrel. 
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Open the file and find the section <SimulationCommands>. It should look like 

this: 

<SimulationCommands> 

<Command Name="ECLIPSE 100"> 

<Submit>eclrun.exe [-v %VERSION%] [-s %SERVER%]  

[-q %QUEUE%] [--username %USERID%] [--passwd %PASSWORD%] 

[%OPTIONS%] eclipse %DATAFILE%</Submit> 

<Fetch>eclrun.exe [--passwd %PASSWORD%] check 

%DATAFILE%</Fetch> 

<Kill>eclrun.exe [--passwd %PASSWORD%] kill 

%DATAFILE%</Kill> 

</Command> 

<Command Name="ECLIPSE 300"> 

<Submit>eclrun.exe [-v %VERSION%] [-s %SERVER%]  

[-q %QUEUE%] [--username %USERID%] [--passwd %PASSWORD%] 

[%OPTIONS%] e300 %DATAFILE%</Submit> 

<Fetch>eclrun.exe [--passwd %PASSWORD%] check 

%DATAFILE%</Fetch> 

<Kill>eclrun.exe [--passwd %PASSWORD%] kill 

%DATAFILE%</Kill> 

</Command> 

<Command Name="FrontSim"> 

<Submit>eclrun.exe [-v %VERSION%] [-s %SERVER%] [-q 

%QUEUE%] [--username %USERID%] [--passwd %PASSWORD%] 

[%OPTIONS%] frontsim %DATAFILE%</Submit> 

<Fetch>eclrun.exe [--passwd %PASSWORD%] check 

%DATAFILE%</Fetch> 

<Kill>eclrun.exe [--passwd %PASSWORD%] kill 

%DATAFILE%</Kill> 

</Command> 

</SimulationCommands> 

The options are: 

• hdf-converter-version 

• summary-conversion 

Suppose you are using ECLRun 2012 and you must support submissions from both 
Petrel 2012 and Petrel 2014. By default, ECLRun starts the newest converter it finds. 
It decides this based on the file system structure, for example \ecl\2012.1\, 
\ecl\2012 etc. If you do not tell ECLRun explicitly to start the 2012 converter for 
submission from Petrel 2014, the converted summary file is rejected by Petrel 2014 
and regenerated locally into the new file format. This can be time-consuming. To 
avoid this, append the submission string of the Submit xml tag with [- - hdf-

converter-version 2012.1] for all the simulators E100, E300, and Frontsim for 

the 2012 PetrelConfiguration.xml file. For example: 
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eclrun.exe [-v %VERSION%] [-s %SERVER%] [-q %QUEUE%] [--username 

%USERID%] [--passwd %PASSWORD%] [%OPTIONS%] [--hdf-converter-

version 2012.1] e300 %DATAFILE% 

To suppress conversion into the new summary file format altogether, use [- - 

summary-conversion=no]. For example, 

eclrun.exe [-v %VERSION%] [-s %SERVER%] [-q %QUEUE%] [--username 

%USERID%] [--passwd %PASSWORD%] [%OPTIONS%] [--summary-

conversion=no] e300 %DATAFILE% 

The location of the xml file is system-dependent. For Windows 7, the default location 
is 
C:\Users\UsernName\AppData\Roaming\Schlumberger\Petrel\Petrel- 

version\. 

Pre-2012 ECLRun 

In this case, ECLRun is unaware of the enhanced summary file format. To complete 
the conversion automatically at the end of the simulation run, use the stand-alone 
converter utility. Contact Schlumberger support to obtain the version you need. Once 
the converter is properly installed, ensure it runs after the end of a successful 
simulation before the simulation results are read back into Petrel. Refer to “Stand-
alone Enhanced Summary Converter Utility” on page D-6 for additional details for 
using the converter. 

Note: If you have changed PetrelConfiguration.xml to include the hdf options, 
you should break simulation submissions from within Petrel 2014 with older 
ECLRun versions in case you should decide to downgrade. 

Custom remote submission systems 

For successful summary conversion, obtain the stand-alone converter from 
Schlumberger support. Supported systems include Microsoft Windows and various 
Linux versions. Contact your system administrator for setup instructions. Refer to 
“Stand-alone Enhanced Summary Converter Utility“ on page D-6 for additional details 
for using the converter. 

Stand-alone Enhanced Summary Converter Utility 

The Windows version of the stand-alone converter is installed with the Petrel 
installation. The executable is named ConvertSummaryData2DataBase.exe and 
is located in the same location as the Petrel application file petrel.exe.  

Note: Usually, the simulation run happens on a cluster. One way to make the 
summary conversion part of the submission workflow is to install the stand-
alone converter on the same machine that runs the simulation. For this, you 
must obtain either the Windows or Linux version of the converter from 
Schlumberger support. 

The converter accepts two mandatory command line options: 

1 Either a directory or a path to a specific (F)SMSPEC file 

2 The directory for storing temporary files 
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If the first argument is a directory, the converter recursively looks for (F)SMSPEC 
files in that directory and converts the corresponding summary data into the new file 
format. In the case of a specific (F)SMSPEC file, only its summary data is 
converted. The second argument could, for example, be C:\TEMP for Windows and 

/tmp for Linux.  

Examples for Windows include:  

• ConvertSummaryData2DataBase.exe C:\Users\hawaii\maui.SMSPEC C:\TEMP 

• ConvertSummaryData2DataBase.exe C:\Users\hawaii\maui 
C:\Users\foo\AppData\Local\Temp 

• ConvertSummaryData2DataBase.exe C:\Users\hawaii\maui %TEMP% 

Linux examples include: 

• ConvertSummaryData2DataBase.exe /home/hawaii\maui.SMSPEC /tmp 

• ConvertSummaryData2DataBase.exe /home/hawaii /users/maui/tmp 

• ConvertSummaryData2DataBase.exe /home/hawaii $TMPDIR 

If you see errors loading shared libraries when trying to run the Linux hdf converter, 
you might need add the path to the shared libraries installed with ECLRun to your 
LD_LIBRARY_PATH environment variable. When using shell csh, this could look like: 

$ setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:/path/to/shared/libraries 

To make this persistent, you must add this command to the shell config file, for 
example .cshrc for csh. 
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General Considerations 

This page lists general comments about behavior, resources, and performance for 
the enhanced summary file format. 

Best Practice Guidelines 

• While Petrel is using the enhanced summary file (extension .h5), the file cannot 
be modified or deleted outside of Petrel. This ensures that the data Petrel works 
with and that the user sees are in sync with the data on the disk. If you still 
need to remove or change the file, you must first remove the simulation results 
for the particular case within Petrel (right-click the simulation case and select 
Remove simulation results). 

• When a project loads, Petrel warns you if any of the enhanced summary files are 
read-only. This might become an issue after a simulation run. In this case, when 
the simulation results are pulled back, Petrel cannot update the enhanced 
summary file returned by the simulation submission. To prevent the display of 
incorrect summary results, Petrel falls back to the standard summary files 
*.(F)SMSPEC and *.A/Sxxxx. A warning is written to the message log. 

• If the option Convert summary data into enhanced summary file format 
(which appears after right-clicking a case) is grayed out, either: 

− Petrel has not found any summary data for this case or  

− The option to use the enhanced summary file format has been cleared on 
the Results import tab on the case 

• When summary data is loaded into Petrel, the old-style summary data is in sync 
with the summary data in the new enhanced summary file. To keep them in 
sync, the converter writes the new keyword TIMESTMP (documented in the 
Eclipse File Format Reference Manual) into the (F)SMSPEC file. This means, for 
conversion to work reliably, that the (F)SMSPEC file cannot be read-only. 

Performance Considerations 

Performance can be an issue if you are working with large summary data sets. In 
any case, the enhanced summary file should be generated as part of the simulation 
run so it is available to Petrel by the time the results come back from remote 
submission. Performance considerations include: 

• The bigger the summary data files, the longer the conversion takes. 

• Make sure you have sufficient main memory. Conversion is faster if more 
memory is available. Roughly, make sure your #physical RAM = 2*size of 
summary files. 

• If the project data is located on a network location, a fast network connection 
pays off 

• You should request only the summary data and report steps you really need. The 
more data you request, the slower the conversion and import into Petrel. 

• If a large amount of physical memory is available, consider setting the 
environment variable SLB_FAST_SUMMARY_READER on the machine that does 
the enhanced file format conversion. This can speed up conversion considerably. 
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